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ABSTRACT 

Zeng, Zhen M.S., Purdue University, May 2014. A Sandbox Development for 
demonstrating BOM transmission in PLM and ERP Integrated system. Major 
Professor: Edie K. Schmidt. 
 
 

Integrating Product Lifecycle Management (PLM) and Enterprise 

Resource Planning (ERP) in a company is important. Currently, many companies 

have difficulties on integrating PLM and ERP systems. This study developed a 

prototype (sandbox) of PLM and ERP integrated system for demonstrating BOM 

transmission in a PLM and ERP integrated system, describing key aspects of 

system integration and BOM transmission. This sandbox will facilitate users’ 

knowledge on how to process transactions in a PLM and ERP integrated system. 

The BOM accuracy was examined by comparing BOM data in PLM system to 

BOM data in ERP system after implementing engineering changes. This study 

was limited to Teamcenter PLM, SAP ERP and Tesis Gateway for SAP.
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CHAPTER 1.  INTRODUCTION 

1.1  Background 

Companies are learning the value of implementing concurrent engineering 

(CE) techniques in reducing time-to-market and cost while increasing quality. 

These changes result from the improvement of coordination within an 

organization (Abdalla, 1999).  One vital part for concurrent engineering practices 

is having tools for managing information within departments. The tools enable 

sharing information between various participants in the product lifecycle and 

ensure this information is consistent and synchronized (Huet, 2009). Two 

systems that are widely used in manufacturing industries as management 

systems for concurrent engineering practices are enterprise resource planning 

(ERP) system and product lifecycle management (PLM) system. 

ERP systems are used to illustrate an extended system for material 

requirements planning, manufacturing resource planning, and computer-

integrated manufacturing. Some well-known ERP software producers include 

SAP, Oracle, and PeopleSoft. It is internal organizational applications, while PLM 

system is product-oriented applications (Hvolby, 2010). The PLM system, which 

evolved from product data management (PDM), typically includes the processes 

of computer-aided design, computer-aided manufacturing, computer-aided 
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engineering, and product data management (Sirnivasan, 2011).  

The benefits of integrating PLM and ERP system include reducing the time-

to-market and cost, ensuring BOM consistency, and standardizing product-

related terminology and processes within an organization (CIMdata, 2005). In 

some cases, manufacturing and production data are stored in a PLM system, 

while the costing and sourcing data are stored in an ERP system. ERP has not 

been the primary location to store design and engineering data, which is usually 

stored in PLM system. To fill the gap in most ERP systems, integrating PLM and 

ERP becomes the most common choice (AberdeenGroup, 2008). However, in 

most cases, companies encompass the loss of efficiency during the initial 

implementation processes of these software systems, as they implement the 

software and learn the new routines in the software at the same time (Davis, 

2004). To implement PLM and ERP integrated system is complicated, as several 

factors should be considered during integration, such as corporate cultures and 

organizational structures, business practices and technology (CIMdata, 2005). In 

addition, when using PLM system and ERP system, the transactions in software 

represent reals business processes and transactions. The users need to develop 

comprehension on making symbol or transaction in the software associated to 

real parts or real business processes in a company. In this situation, users who 

are lack of experience in the functional area of a company can have difficulty on 

understanding the business processes embedded in the software. When fail to 

relate the operational task in software systems to a business process in a 

company, users have difficulty to correct errors and understand impacts of their 
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works on others (Davis, 2004). An industry-based business process model and 

the implemented working information system can provide a platform for users to 

develop problem based learning experience on software systems, as it facilitates 

users’ comprehension of relations between organizational business process and 

information systems, and leads users to think about how to solve business 

problems by using technical solutions of software systems (Stewart, 2008). 

 

1.2  Statement of the problem 

 Many companies have difficulties implementing a PLM and ERP integrated 

system, especially for transferring BOM data consistently. This study 

documented the sandbox development for demonstrating BOM transmission in 

PLM and ERP integrated system. The results of this study can help to enhance 

user’s comprehension of relations between business processes and transactions 

in PLM and ERP integrated system. 

 

1.3  Significance 

Integrating PLM and ERP in a company is important to reduce the time-to-

market and costs of new products, as it ensures consistency and use of product 

related information throughout the company. However, it is difficult to integrate 

PLM and ERP in a company, especially for BOM data. Generally, the difficulties 

of implementing PLM and ERP integrated system are attributed to these two 

aspects. On one hand, several factors should be considered during integration, 
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such as corporate cultures and organizational structures, business practices and 

technology (CIMdata, 2005); on the other hand, users who are lack of experience 

on software systems can have difficulty on understanding the business 

processes embedded in the software(Davis, 2004). In this situation, a report that 

address key steps of integration for specific work scenarios could help them to 

better understand transactions embedded in the PLM and ERP integrated 

system. 

However, most existing reports on integrating PLM and ERP are developed 

to emphasize the benefits and strategies; very few reports address key 

processes of integration for specific work scenarios. Few researchers in 

academia generate papers about implementing PLM and ERP integration system, 

as it is expensive to purchase either PLM or ERP software and then develop 

integrated system in lab environment. While in industry, companies who 

implemented PLM and ERP integrated system are hesitated to share their 

experiences on system integration publically by using their data, as in most 

cases, the data used in PLM and ERP integrated system are sensitive. Some 

consulting companies, such as CIMdata, Aberdeen Group, generate reports 

about issues on PLM and ERP integrated system, but these reports focus on 

benefits and strategies of PLM and ERP integrated system. Therefore, it is 

meaningful to generate a report that emphasizes on key steps of transactions in 

PLM and ERP system for specific work scenarios, as it can enhance user’s 

comprehension of relations between business processes and transactions in 

PLM and ERP integrated system.  
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1.4  Purpose of the study 

The purpose of this project was to provide information related to a sandbox 

development for demonstrating BOM transmission in PLM and ERP integrated 

system by documenting key considerations of integration and key steps of BOM 

transmission. The questions central to this research are: 

1. What are key considerations of integrating PLM and ERP to transfer 

BOMs? 

2. What are key steps of transferring BOM in a PLM and ERP 

integrated system? 

 

1.5  Assumptions 

The assumptions of this research included: 

 a successful integration of PLM and ERP depended on factors from 

corporate cultures and organizational structures, business practices, and 

technology (CIMdata, 2005); 

 the barriers of integrating PLM and ERP were intentionally ignored in 

order to focus on basic steps of integration; and 

 the BOM structure in this study represents a general BOM structure. 

 



6 
 

 

1.6  Limitations 

1. The framework of integration in this study would be more complicated 

when discussing integration besides the technical perspective (Kahkonen, 

2013). 

2. The key considerations of PLM and ERP integrated system and the key 

steps of BOM transmission that listed in this study may change depending 

on requirements of integration objectives and workflow designs. 

 

1.7  Delimitations 

1. The software used in this research was limited to Teamcenter PLM, SAP 

ERP and Tesis Gateway for SAP, which are donated software at Purdue 

University. 

2. The BOM information transferred in this study was limited to BOM 

structure and material information. 

 

1.8  Summary 

This chapter provided an overview of PLM and ERP transmission needs. 

The statement and significance of the problem were reviewed, and assumptions, 

limitations and delimitations in this study also were discussed. Many companies 

have difficulties to make consistent data transmissions between PLM and ERP, 

especially for BOM data. This study provided detailed information related to a 

sandbox development for demonstrating BOM transmission in PLM and ERP 
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integrated system. This study can enhance user’s comprehension of relations 

between business processes and transactions in PLM and ERP integrated 

system. 
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CHAPTER 2.  LITERATURE REVIEW 

In this chapter, literature related to the methodology of PLM and ERP 

integration including the benefits, considerations and methods of integrating PLM 

and ERP system are reviewed from the research reports, which are generated by 

top consulting companies- Aberdeen Group and CIMdata, Inc.. In the section of 

software information, the information of software used in this research is listed. In 

order to understand work scenarios of BOM transmissions, concurrent 

engineering scenarios and types of BOMs are also reviewed from journals and 

conference papers by searching with the key words of concurrent engineering, 

engineering change management, and bill of material. 

 

2.1  Integrate PLM and ERP  

ERP system is used to illustrate an extended system for material requirements 

planning, manufacturing resource planning, and computer-integrated 

manufacturing. It is internal organizational applications, while PLM system is 

product-oriented applications (Hvolby, 2010). A PLM system typically includes 

the processes of computer-aided design, computer-aided manufacturing, 

computer-aided engineering, and product data management (Sirnivasan, 2011). 
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ERP has not been the primary location to store design and engineering data, 

which is usually stored in PLM. To fill the gap in most ERP systems, integrating 

PLM and ERP becomes the most common choice, as shown in Figure 2.1 

(AberdeenGroup, 2008). Companies are classified into three categories: the top 

 

 

Figure 2.1 The integration of PLM across the enterprise ecosystem 

(AberdeenGroup, 2008) 

20% (Bestin-class), the middle 50% (Industry Average) and the bottom 30% 

(Laggard) of performers. In Table 2.1, 90% of information flows are sending 

BOMs from PLM to ERP, and 60% of them are sending change orders. It is 

because companies store data of item parts, EBOM, configurations, product 

graphics and item specifications in PLM systems, while storing data of item costs, 

and MBOM in ERP system. 

 

Table 2.1  

Data integration from PLM to ERP  (AberdeenGroup, 2008) 

  Best-in-Class Industry Average Laggard 

Bills of Materials(BOMs) 90% 93% 86% 
Change orders 60% 60% 71% 



10 
 

 

2.1.1 Implementation consideration of integration 

Integration is defined from a technical perspective as data exchanging happen 

between at least two interconnected systems (Kahkonen, 2013). Business 

systems integration can be discussed from the dimension of information 

integration, where information is sharing directly, and the dimension of 

synchronized planning, where engineering changes are synchronized in the 

integrated business systems (Hvolby, 2010). When implementing PLM and ERP 

integrated system, several factors should be considered. These factors include 

organizational and cultural factors, business practice factors and technology 

factors (CIMdata, 2005). For organizational and cultural factors, it is important to 

determine which system is the master and which system owns and controls 

information and processes. Integrating PLM and ERP is a process of eliminating 

overlaps of functionality and processes in a company (CIMdata, 2005). For 

business practice factors, a key step is to understand how a specific business 

operates. An effective integration should address the direction of data flow and 

add process automation whenever possible, as it reduces non-value added work 

significantly (CIMdata, 2005). For technology factors, some factors should be 

considered, including:  

 The type of information to be integrated: generally, starts from the 

information of product structure and BOM exchange, and then covers 

change information (CIMdata, 2005). 

 The processes to be supported: to determine what information should 

be exchanged and what information should be accessible, and what 
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process steps should be managed in which systems (CIMdata, 2005). 

 The type and complexity of integration required: to determine the level 

and direction of data flow. Is it one-way transfers or bi-directional 

exchange? What information should be exchanged between PLM and 

ERP? (CIMdata, 2005). 

 The tools and methods to be used to create and maintain the 

integration (CIMdata, 2005). 

 

2.1.2 Approaches of integration 

Three primary methods for PLM and ERP integration are generally used as 

shown in Fig2.2. The Encapsulation is a relatively simple solution, which is easier 

 

 

Figure 2.2 The methods for integration (CIMdata, Inc., 2005) 

to implement than other two, as it usually takes only person days to complete. 

The Interface is more difficult to implement than Encapsulation, and usually takes 
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person weeks to complete. The Integration is the most difficult to implement of 

these three solutions, and usually takes person months to person years to 

complete (CIMdata, 2005). 

Multiple approaches can be chosen for integration, no matter which method 

and starting point are chosen, and one approach is an Enterprise Application 

Integration (EAI) tool. Compared to other approaches, the cost and required 

resource can be reduced due to the decreased number and complexity of 

integrations (CIMdata, 2005). In addition, EAI is usually for integrating 

information systems within a single company (Kahkonen, 2013). 

 

2.1.3 Training on software systems 

Companies encompass the loss of efficiency during the initial implementation 

processes of software systems, as they implement software and learn new 

routines in the software at the same time (Davis, 2004). When using PLM and 

ERP software systems transactions represent real business processes and 

transactions, the users need to develop knowledge to make symbols or 

transactions in the software associated with productions parts or real business 

processes in a company. In this situation, a user without experience in the 

functional area of a company can have difficulty understanding the business 

processes embedded in the software. Failure to relate the operational task in 

software systems to a business process in a company result in users having 

difficulty correcting errors and recognizing the impacts of their works on others 

(Davis, 2004). An industry-based business process model and the implemented 
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working information system can provide a platform for users to develop problem 

based learning experience on software systems, as it facilitates users’ 

comprehension of relations between organizational business process and 

information systems, and leads users to think about how to solve business 

problems by using technical solutions of software systems (Stewart, 2008). 

 

2.2  Software information 

In this section, the information regarding software that was used in this 

research is reviewed. All software was donated by Purdue industry partners. 

 

2.2.1 PLM system 

The Siemens Teamcenter PLM (TC PLM) system is one of the most widely-

used PLM solution suites in the market and is used by more than 6,400 

customers across about 9,900 operations with 5 million licensed seats. The first 

version of Teamcenter was released as computer-aided design (CAD) data 

management software in the mid 1980’s. In 2007, Siemens released Teamcenter 

2007, which has a four-tier unified architecture incorporating the latest 

technology and business functionality. In 2009, Teamcenter 8 was released, 

which is designed to make customer configuration and expedition of functionality 

easier than before (Siemens, n.d.).  

The Teamcenter PLM system covers three foundational areas, which are 

enterprise knowledge foundation, platform extensibility services and lifecycle 

visualization. These foundational areas contain 14 functional areas, such as 
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BOM management, engineering process management, maintenance, repair, and 

overhaul (MRO), and manufacturing process management (Siemens, n.d.).  

 

2.2.2 ERP system 

The SAP ERP software is one of market-leading enterprise resource planning 

software used by nearly 50,000 customers over the past 40 years. This ERP 

software covers key areas within organization, such as manufacturing, sales, and 

finance, and is designed to satisfy information needs for small to large 

businesses including multi-lingual and multi-currency functionalities (SAP, 

n.d.).The latest version of SAP ERP is released as SAP ERP 6.0. Compared to 

previous versions of SAP ERP, SAP ERP 6.0 enhances capabilities for finance, 

procurement, and human capital management by providing automated financial 

and management accounting and financial supply chain management to users; 

managing end-to-end procurement and logistics business processes for whole 

business cycles; and supporting the innovation, core human resource processes 

and workforce deployment (SAP, n.d.).   

However, the SAP ERP system is strong in functionality but complicated to 

use. In order to inspire users to master SAP software, ERPsim Lab designed 

SAP ERP simulation games as a learning-by-doing approach for educational 

purposes. These ERP simulation games include the distribution game, the 

logistics game, and the manufacturing game (ERPsimLab, 2012). In the ERP 

simulation game participant’s guide, key concepts and processes for setting up a 

simulation client are listed. As one of the cornerstones of a client in SAP ERP 
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system, master data are stored in ERP system’s central database, and are used 

in many business processes within organizations. Figure 2.3 shows the main  

 

 

Figure 2.3 Conceptual model of the main master data of SAP ERP client in the 

simulation game (ERPsimLab, 2012) 

master data of SAP ERP client in the conceptual model including BOM, raw 

material, information record, vendor, finished product, work center, and routing. 

In addition, the relationship of master data with organizational elements and 

other master data are shown in Table 2.2. The main master data can be grouped 

as material master, production master data, purchasing master data, financial 

master data, and cost controlling master data (ERPsimLab, 2012). 
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Table 2.2  

The relationship of master data (ERPsimLab, 2012) 

Master Data 
Relationship with organizational 

elements 
Relationship with other master 

data 

Material master     

Finished 
products 

 
Link to a plant, a storage location, 
a sales organization and one or 
more distribution channels 

The composition of a finished 
product is shown in the BOM 

 
 
Raw 
materials 

 
 
Link to a plant and a storage 
location 

The raw materials are included in 
the BOM 

Production master 
  

 
BOM (Bill of 
material) 

 
Link to a specific plant defined for 
a specific product 

 
Link the finished products with the 
raw material 

 
Work centers 
 

The work centers are located in a 
specific plant 

 
A work center must be specified 
for each operation defined by the 
routing 

 
Routings Routings are specific to a plant 

 
The finished products and work 
centers are related to routings. 

Purchasing master 
  

Vendors 
 
 

Vendors are defined for a company 
code and a purchasing 
organization. 

Vendors are linked to raw 
materials they sell through 
the info-records. 

Info-records 
 

The logical tie between a vendor 
and a raw material. 

 
Info records link the 
vendors with the raw 
materials they provide. 

Source list 
 
 
 
 

Specific to a plant and a 
purchasing organization. 
 
 
 

 
Tie together an 
approved/blocked vendor 
to a material. Info-records 
need to be created before 
a material can be put on a 
source list. 
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2.2.3 EAI system  

EAI system is enterprise application integration system. Tesis Teamcenter 

Gateway for SAP (T4S) is the SAP certified EAI system for integrating Siemens 

Teamcenter PLM system with SAP applications. This software ensures 

consistent data transmissions across functional divisions by controlling data 

sharing and providing intelligent data mapping (Tesis, n.d.-a). In the integrated 

system shown in Figure 2.4, various information types in the TC PLM system 

 

 

Figure 2.4    The sample of data map in TC PLM and SAP ERP integrated 

system with T4S (Tesis, n.d.-a) 

including Item, Item Revision, BOMView and Operations are connected with the 

related information types in the SAP ERP system, such as Material Master, BOM, 

and Operations (Tesis, n.d.-a). For these information types in the TC PLM 

system, T4S defines seven object types including Material Master, Bill of Material, 

Document Info Record, Engineering Change Master, Equipment Master, 

Functional Location and Vendor, while adopting nine transaction types, such as, 

create, change, display, and reserve (Tesis, n.d.-a). 



18 
 

 

 

One of the popular transfer directions in TC PLM and SAP ERP integrated 

system by using T4S is to transfer data from TC PLM to SAP ERP. The T4S can 

build a bidirectional communication from TC PLM to SAP ERP. The T4S process 

 

 

Figure 2.5 The data transmission processes in TC PLM and SAP ERP integrated 

system through T4S (Dirk, 2012) 

flow for transferring data from TC PLM to SAP ERP has two steps. As shown in 

Fig 2.5, the first step is forward mapping, which includes reading item information 

from TC PLM, creating the material master object in SAP ERP; and the second 

step is reverse mapping, which reads SAP material master object and sends to 

TC PLM (Dirk, 2012). 
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2.3 Concurrent engineering scenarios 

In concurrent engineering (CE) system, the product design and related 

manufacturing processes are developed simultaneously. Typically, an integration 

is accomplished by cross-functional groups (Smith, 1997). Compared to 

traditional sequential business processes, concurrent engineering systems have 

a simultaneous design and manufacture process, which aims to reduce total time 

and costs for a product from concept to delivery, while satisfying both consumers 

and industrial customers (Prasad, 1998).  

Benefits of implementing CE techniques in global manufacturing include 

reducing time-to-market and cost and increasing product quality. These benefits 

come from the improvement of coordination within the whole organization 

(Abdalla, 1999).  The best practices of CE show that information system software 

for managing information within departments is vital. The information system 

software provide platforms for sharing information between various participators 

in product lifecycles and ensuring that information is consistent and synchronized 

(Huet, 2009). 

 

2.3.1 Engineering change management 

Engineering change (EC) is used to describe change of products or 

constituent components. Three typical types of EC include engineering change 

involving drawing changes only, engineering change involving drawing and BOM 

changes and engineering change involving BOM changes only (Balcerak, 1992). 

In most cases, a poor engineering change control might cause a low BOM 
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accuracy, as these changes bring a series of downstream changes (Huang, 

2001). Typical working scenarios of concurrent engineering in industry are 

presented in Table 2.3 (Sobek, 1999). In example 1, design engineers make an 

agreement with manufacturing engineers on product design, while in example 2, 

3, and 4, design engineers discuss manufacturing design limits with 

manufacturing engineers, and works on modifying initial product design for better 

functional performance as well as meeting manufacturing design requirements. 

 

Table 2.3 

Examples of concurrent engineering (Sobek, 1999) 

  Example 1 Example 2 Example 3 Example 4 

Design 
Engineering 
 
 
 
 
 

"We've come 
up with several 
designs that 
would meet 
our functional 
requirements. 
They look 
roughly like 
this" 

"Great. We 
will work 
within these 
limits and 
keep you 
posted on 
developments
" 

"We've 
narrowed the 
possibilities to 
this set and 
also fleshed 
out some more 
of the detail" 

"This is very 
close to you final 
design. Please do 
your final 
manufacture 
ability review." 

Manufacturing 
Engineering 
 
 
 

"Our 
manufacturing 
capabilities are 
best suited for 
designs with 
these 
characteristics"

"OK. We can 
handle any 
solution in 
that set. This 
is enough 
information to 
order tool 
steel and start 
process 
planning" 

"Looks good. 
Your set is still 
within our 
capabilities. 
We have some 
minor design 
changes to 
request, then 
we'll order 
castings" 

"This design 
looks good. 
Thanks for 
including us early 
on. We'll start 
fading the tools 
and get into pilot 
as soon as 
possible!" 
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2.3.2 Bill of material 

A class and relationship hierarchy model for bill-of-materials is listed as Fig 2.6. 

A BOM generally contains three major subclasses, which are end-product, 

subassembly, and component, which is also called as part. The end-product is 

 

 

Figure 2.6 The class and relationship hierarchies for BOM and operation  

(Jiao, 2000) 

 

 composed by subassemblies or components, and a subassembly is composed 

by components (Jiao, 2000). The accuracy of BOM is measured from four 

perspectives: the part numbers, the quantity per unit, the unit of measure, and 

the structure (Garwood, 1997). In an accurate BOM, the right part numbers are 

listed, and each part is with right quantity per unit. Meanwhile, the unit of 

measure in quantity per unit and the structure are correct. 
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CHAPTER 3.  METHODOLOGY 

The purpose of this project was to provide documentation of the processes for 

developing a sandbox for a PLM and ERP integrated system, which will transfer 

BOM data. This chapter illustrates the methods used in this study, including the 

PLM and ERP integrated platform building and configuration, and BOM 

transmission processes in concurrent engineering scenarios. 

 

3.1 Framework of integrating PLM and ERP 

Integration is defined from a technical perspective as data exchange between 

at least two interconnected systems (Kahkonen, 2013). Business systems 

integration can be discussed in the dimension of information integration, where 

information is sharing directly, and the dimension of synchronized planning, 

where engineering changes are synchronized in the integrated business systems 

(Hvolby, 2010). This study discussed the framework of integrating PLM and ERP 

from a technical perspective, especially on the dimension of information 

integration and synchronized planning. Several considerations and factors were 

addressed for integration. For organizational and cultural factors, it is important to 

determine which system is the master, and which system owns and controls 

information and processes. Integrating PLM and ERP eliminates the overlap of 
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functionality and processes in a company. For business practice factors, it is key 

to understand how a specific business operates, to address the direction of data 

flow and to add process automation whenever possible, and reduce non-value 

added work significantly. Further, for technology factors, it is crucial to consider 

the type of information to be integrated, the processes to be supported and the 

type and complexity of integration required (CIMdata, 2005). The framework of 

integrating PLM and ERP was set by answering these questions listed as 

following: 

1) Which system is the master? Which system owns and controls information 

and processes? 

2) What type of information should be integrated? 

3)  What is the direction of data flow? What process automation can be 

added? 

4) What information should be accessible?  

5) Which process steps should be managed in which systems? 

6) What information should be exchanged between PLM and ERP? 

7) Which tool and method could be used to create and maintain integration? 

 

3.2 Systems configuration 

The ERP system was SAP ERP 6.0, EHP 6 with SP 4, the PLM system was 

Siemens TC PLM 9.1 and the EAI software was T4S V9.1. T4S is SAP certified 

software for integrating TC PLM with SAP applications. T4S ensures consistent 

data transmissions across functional divisions by controlling data sharing and 
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providing intelligent data mappings. Fig 3.1 illustrates the PLM and ERP 

integrated platform design for this study. 

 

 

Figure 3.1 TC PLM and SAP ERP integrated system design 

 

3.2.1 Software platform development 

Technical support for the selected software was provided by Purdue technical 

support groups from Information Technology at Purdue (ITaP) and Purdue 

Engineering Computer Network (ECN). Support groups for this study helped 

install and build the PLM and ERP integrated system platform. In order to build 

the TC PLM and SAP ERP integrated system platform, TC PLM, SAP ERP and 

T4S system were installed by IT support from ITaP and ECN in this study. The 

SAP ERP system was installed and key installation activities are listed below.  

1) Obtain the SAP Master Guide, Installation Guide and the Central 

Installation notes for SAP ERP 6.0 

2) Determine the Operating System requirements by reviewing the SAP 

Master Guide and Installation Guide 
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3) Plan the SAP ERP system layout based on the customer requirements 

4) Obtain the necessary installation media from SAP and stage it on the 

servers 

5) Install the SAP ERP 6.0 system 

6) Create user accounts 

7) Test and confirmed network connectivity 

The TC PLM and T4S system were installed by IT support from ECN, and were 

maintained in the College of Technology Product Lifecycle Management Center. 

The key processes for installing TC PLM included the following steps. 

1) Obtain the TC PLM 9.1 Installation Guide 

2) Develop a server for TC PLM 9.1 

3) Obtain the installation media for TC PLM 9.1 

4) Install TC PLM client based on customer requirements 

5) Test the network connectivity 

For installing the T4S system, the key processes included: 

1) Obtain the T4S installation Guide 

2) Install T4S BGS on TC PLM server 

3) Install T4S client code 

4) Install T4S data model templates 

5) Test the network connectivity 

The validation of installation method was implemented by the TC PLM and SAP 

ERP system experts at Purdue. When the TC PLM and SAP ERP systems were 
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installed, the TC PLM expert from ECN and the SAP ERP experts from ITaP 

evaluated the initial configuration of the TC PLM and SAP ERP system. 

 

3.2.2 The TC PLM configuration design 

The product data selected for this study was a 3-D product created by 

undergraduate students in CGT 423. The END-PRODUCT was 5-3-18. The BOM 

structure was generated based on three major subclasses of BOM (Jiao, 2000). 

Figure 3.2 shows the product overview. There are three subassemblies: 5-2-2, 5-

2-12 and 5-2-11 included in BOM 5-3-18. Each subassembly contains several 

components. The quantity of component 5-1-7, 5-1-8 and 5-1-9 is two, and the 

quantity of other components is one. Appendix A shows the detailed steps of 

product configuration in TC PLM system in this study.    

 

 

Figure 3.2  5-3-18 overview and BOM structure 
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3.2.3 The SAP ERP configuration design 

For an SAP ERP client, the organizational elements and main master data are 

configured. Fig 3.3 shows the data model of organizational elements in SAP ERP 

client in this study, which contains company code, plant, controlling area, 

purchasing organization, storage location, plant, distribution channel, sales 

organization, and division (ERPsimLab, 2012). 

 

 

Figure 3.3  Data model of organizational elements in SAP ERP company client in 

this study 

 

3.2.4 The T4S configuration design 

The author performed the T4S preference configuration, identifying the object 

and transaction type sharing between PLM and ERP system. Configuration 

design generally contains two key steps. The first step is to define the object to 

be supported in T4S GUI, and the second step is to choose the transaction type 

to be transferred between TC PLM and SAP ERP. In the first step, there are 

seven object types included in T4S configuration, such as Material Master, Bill of 
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Material, Document Info Record, Engineering Change Master, Equipment Master 

and Vendor, which are shown in Fig. 3.4. The configuration of T4S covered four 

 

 

Figure 3.4 The screen print of T4S configuration object and transaction types 

object types: Material Master, Document Info Record, Bill of Material, and 

Change Master. In the second step, there were nine transaction types included in 

T4S configuration including create, change, display, reserve and link. The 

configuration of T4S covered two transaction types: create and display (Tesis, 

n.d.-b). The T4S Configuration Guide and Installation Guide were used as 

references during configuration. Appendix B lists out the details of configuring 

T4S in this study. 

 

 

3.3 BOM transmission process 

This research developed a sandbox for the TC PLM and SAP ERP integrated 

systems to transfer BOM information in concurrent engineering in a laboratory 
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environment. The BOM transmission processes were designed under three 

scenarios:  

 Scenario 1: Transmit BOMs from the TC PLM system to the SAP ERP 

system;  

 Scenario 2: Synchronize a related BOM in the SAP ERP system after 

revising a BOM in the TC PLM system;  

 Scenario 3: Import a new part from the SAP ERP system to the TC PLM 

system, and synchronize a related BOM in the SAP ERP system after 

adding this new part to a BOM in the TC PLM system.  

 

Table 3.1  

Examples of concurrent engineering (Sobek, 1999) 

  Example 1 Example 2 Example 3 Example 4 

Design 
Engineering 
 
 
 
 
 

"We've come 
up with 
several 
designs that 
would meet 
our functional 
requirements. 
They look 
roughly like 
this" 

"Great. We will 
work within 
these limits and 
keep you 
posted on 
developments" 

"We've narrowed 
the possibilities to 
this set and also 
fleshed out some 
more of the detail" 

"This is very close 
to you final design. 
Please do your final 
manufacture ability 
review." 

Manufacturin
g Engineering 
 
 
 

"Our 
manufacturing 
capabilities 
are best suited 
for designs 
with these 
characteristics
" 

"OK. We can 
handle any 
solution in that 
set. This is 
enough 
information to 
order tool steel 
and start 
process 
planning" 

"Looks good. Your 
set is still within our 
capabilities. We 
have some minor 
design changes to 
request, then we'll 
order castings" 

"This design looks 
good. Thanks for 
including us early 
on. We'll start 
fading the tools and 
get into pilot as 
soon as possible!" 
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These three scenarios were generated from the typical concurrent engineering 

working scenarios in industry as shown in Table 3.1(Sobek, 1999). In Table 3.1 

example 1, a design engineer made an agreement with a manufacturing 

engineer on product design. Scenario 1 illustrated a BOM transmission process 

under this situation, where BOM data was transmitted directly from TC PLM to 

SAP ERP, which generated the related BOM in SAP ERP system for 

manufacturing purposes. In Table 3.1 example 2, 3, and 4, a design engineer 

discussed manufacturing design limits with a manufacturing engineer, and 

worked on modifying initial product design for better functional performance, as 

well as meeting manufacturing design requirements. In scenario 2, a new product 

part was added on a BOM in TC PLM system, and a related BOM in SAP ERP 

was updated through engineering change management workflow, while in 

scenario 3, a new product part was imported from the SAP ERP system into TC 

PLM system. After adding this new part on BOM in TC PLM system, the related 

BOM in SAP ERP was synchronized. The screen prints show key steps for 

transferring BOM between the TC PLM and SAP ERP integrated system were 

documented in Chapter 4. In Chapter 5 the research results observed in this 

study were analyzed. 

 

3.3.1 Scenario 1 

In this scenario, a related BOM in SAP ERP was created from a BOM in TC 

PLM by using the T4S model -- Material Master and Bill of Material. In this study, 

the product parts of 5-3-18 are defined as end-products in the TC PLM system. 
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The BOM data in SAP ERP were compared to the BOM data in TC PLM in part 

number, quantity, unit and structure, as these four indexes are key 

measurements of BOM accuracy in Garwood (Garwood)’s research.  

Step 1: Opened BOM 5-3-18 in TC PLM structure manager screen by 

searching 5-3-18 in search bar. 

Step 2: Moved all product parts from TC PLM to SAP ERP through T4S 

model by clicking T4S Gateway-> Material Master-> Create Direct 

Step 3: Checked the moved materials in SAP ERP system by using 

transaction code MM03. 

Step 4: In “My Teamcenter” screen, moved BOM Structure from TC PLM to 

SAP ERP by clicking T4S Gateway-> Bill of Material -> Create Direct. 

Step 5: Checked the material BOM of finished product in SAP by using 

transaction code CS03. 

 

3.3.2 Scenario 2 

In this scenario, a new part was added on a BOM in TC PLM system, and then 

the related BOM in SAP ERP system was synchronized by using T4S model 

“Change Master”. The product parts of 5-3-18 are defined as end-product in TC 

PLM system. The BOM data in SAP ERP were compared to the BOM data in TC 

PLM in part number, quantity, unit and structure.  

The key steps of transactions in scenario 2 included: 

Step 1: In “Structure Manager” screen, clicked 5-3-18, and then created a 

new part 5-1-99 under BOM 5-3-18 in TC PLM. 

Step 2: Moved 5-1-99 from TC PLM to SAP ERP. 

Step 3: Updated the related BOM in SAP ERP through TC PLM workflow 

process of T4S_BOM. 
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Step 4:  Checked the related BOM in SAP ERP system by using 

transaction code CS03. 

Step 5: In “My Teamcenter” screen, created change request S2 and 

attached 5-3-18 to it by copying and pasting 5-3-18 in the folder of 

affected items. 

Step 6: Created a change master for the related BOM in SAP ERP by using 

T4S model change master-create direct. 

Step 7: Checked the change master created in SAP ERP system by using 

transaction code CC03. 

Step 8: In “My Teamcenter” screen, released the change request S2 

through workflow process of T4S_ECM. 

 
 

3.3.3 Scenario 3 

In this scenario, a new part was imported from SAP ERP to TC PLM. After 

adding this new part to a BOM in TC PLM, the related BOM in SAP ERP was 

synchronized through T4S model. The BOM data in SAP ERP were compared to 

BOM data in TC PLM in part number, quantity, unit and structure. The key steps 

of transactions in scenario 3 included: 

Step 1: Created a new product part by using transaction code MM01 in 

SAP ERP. 

Step 2: Searched new product part TE00R stored in SAP ERP by opening 

search view, and choosing T4S_DEMO_QUERY in TC PLM. Imported this 

new product part from SAP ERP into TC PLM by importing T4S Query row. 

Step 3: Searched  TE00* in search bar and added TE00R to 5-3-18 by 

copying and pasting TE00R to 5-3-18 BOM structure in TC PLM-Structure 

Manager screen. 
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Step 4: Updated the related BOM in SAP ERP through T4S_BOM workflow. 

Step 5: Checked the related BOM in SAP ERP system by using transaction 

code CS03. 

Step 6: Created change request S3 in TC PLM system, and attached 5-3-

18 to this Change Revision in TC PLM-My Teamcenter screen. 

Step 7: Created a change master for the related BOM in SAP ERP system. 

Step 8: Checked the SAP change master in SAP ERP system by using 

transaction code CC03. 

Step 9: Released the change revision through workflow process of 

T4S_ECM.  

 

3.4 Summary 

A framework of integrating PLM and ERP was developed by considering 

organizational and cultural factors, business practice factors and technology 

factors. Three BOM transmission scenarios were designed based on concurrent 

engineering work scenarios. The BOM transmission processes were validated by 

visually comparing BOM data from part number, quantity, unit and structure. The 

BOM transmission scenarios were performed on two computers. The TC PLM 

system was operated on computer in PLM laboratory, while the SAP ERP system 

was operated from the Supply Chain Management Technology (SCMT) 

laboratory. When preceding the BOM transmission scenario, both the TC PLM 

and SAP ERP were opened in the SCMT lab by remotely controlling the 

computer for TC PLM. The BOM data in TC PLM and SAP ERP was shown on 
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two parallel screens. By visually comparing BOM data in two screens after each 

transaction, the BOM transmission scenarios were validated. 
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CHAPTER 4.  RESEARCH RESULTS 

In this chapter, research results in this study are described. The key 

considerations of PLM and ERP integrated system are analyzed and the screen 

prints of key steps of transferring BOM in TC PLM and SAP ERP integrated 

system are documented. 

 

4.1 Key considerations of integrating PLM and ERP 

This study adopted the framework of integrating PLM and ERP by 

summarizing key considerations and factors of integration in CIMdata report 

(CIMdata). The key considerations of PLM, ERP and EAI system in this research 

were determined by answering questions in the framework of integration. These 

key considerations include data and process ownership, master source of 

information, and the level of integration. The answers of questions in the 

framework of integrating PLM and ERP are listed as following: 

1) Which system is the master? Which system owns and controls information 

and processes? 

The PLM and ERP system have similar functionalities in data and process 

management. From the technique’s perspective, either PLM or ERP can be 

defined as the master, which system owns and controls information and 
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processes. Typically, the processes of engineering reside in the PLM system, 

while the processes of manufacturing reside in the ERP system. BOM and 

change requests were shared between the PLM and ERP integrated system. In 

order to ensure the data consistency, the PLM system was assigned as “owner” 

and “controller”, as the BOM and change request data was initially generated 

from engineering processes. The PLM system was the only source of BOM and 

change request data.    

2) What type of information should be integrated? 

The processes of engineering design and change management was included. 

As BOM and change request information is associated with the processes of 

engineering design and change management, the information from the BOM and 

change request data should be integrated between PLM and ERP. 

3) What is the direction of data flow? What process automation can be added? 

PLM was the “master, so to ensure that PLM is the only source of BOM and 

change request, BOM and change request transmission was defined as one-way 

directional from PLM to ERP.  While the product part information is bi-directional 

between PLM and ERP, as in concurrent engineering scenarios where the 

design engineer who manages the PLM system data or the sourcing engineer 

who manages the ERP system data, and may create new product part data. The 

process of synchronizing the BOM and creating the related change request in 

ERP can run automatically by using EAI, as the EAI tool has pre-configured 

packages for this functionality.  

4) What information should be accessible?  
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In concurrent engineering scenarios adopted in this study, the manufacturing 

engineer in the ERP system can check BOM and change request data created 

by design engineer in PLM system, so the BOM and change request data should 

be accessible in both systems.   

5) Which process steps should be managed in which systems? 

As PLM is the only source of BOM and change request data in this study, and 

the EAI tool has the functionality to automatically create BOM and change 

request in the ERP system, so the process of creating and editing BOM and 

change request data should be managed in the PLM system.  The process of 

creating new product parts was managed in both PLM and ERP systems in this 

study, because in concurrent engineering scenarios adopted in this study, the 

design engineer (PLM) needed to use new parts created by sourcing engineer  

(ERP). The EAI tool has the functionality to import data from SAP ERP to TC 

PLM. 

6) What information should be exchanged between PLM and ERP? 

The BOM and the data which is associated with BOM synchronization 

processes should be exchanged between PLM and ERP. 

7) Which tool and method could be used to create and maintain integration? 

The EAI tool T4S was used to create and maintain integration in this study, as 

it is the SAP certified EAI system for integrating Siemens TC PLM system with 

SAP applications, and was provided by our vendor partner in this study.   
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4.2 BOM transmission transactions  

In this section, the BOM transmission transactions under three concurrent 

engineering scenarios were documented. The results were analyzed in chapter 5. 

 

4.2.1 Scenario 1 

In this scenario, a related BOM in SAP ERP was created from BOM 5-3-18 in 

TC PLM. All product parts and BOM structure was created in SAP ERP through 

T4S model-- Material Master and Bill of Materials. The BOM data transferred in 

PLM and ERP integrated system were recorded in Table 4.1. 

 

Table 4.1  

The records of BOM 5-3-18 in scenario 1 

  
BOM in TC PLM 

   
  

BOM in SAP ERP 

Part No. 
Qua
ntity  

Unit   Structure 
 Part 

No. 
Qua
ntity 

Unit   Structure 

               
5-3-18 1 Each End-Product  5-3-18 1 Each End-Product 
5-1-1 1 Each Component  5-1-1 1 Each Component 
5-2-2 1 Each Subassembly  5-2-2 1 Each Subassembly 
5-1-3 1 Each Component  5-1-3 1 Each Component 
5-1-6 1 Each Component  5-1-6 1 Each Component 
5-1-7 2 Each Component  5-1-7 2 Each Component 
5-1-8 2 Each Component  5-1-8 2 Each Component 
5-1-10 1 Each Component  5-1-10 1 Each Component 
5-2-11 1 Each Subassembly  5-2-11 1 Each Subassembly 
5-1-4 1 Each Component  5-1-4 1 Each Component 
5-1-5 1 Each Component  5-1-5 1 Each Component 
5-1-9 2 Each Component  5-1-9 2 Each Component 
5-2-12 1 Each Subassembly  5-2-12 1 Each Subassembly 
5-1-13 1 Each Component  5-1-13 1 Each Component 
5-1-14 1 Each Component  5-1-14 1 Each Component 
5-1-15 1 Each Component  5-1-15 1 Each Component 
5-1-16 1 Each Component  5-1-16 1 Each Component 
5-1-17 1 Each Component  5-1-17 1 Each Component 
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Step 1: Opened BOM 5-3-18 in TC PLM structure manager screen as 

shown in Fig 4.1 by searching 5-3-18 in search bar. 

 

 

Figure 4.1 Screen print of BOM 5-3-18 in TC PLM 

 

Step 2: Moved all product parts from TC PLM to SAP ERP through T4S 

model as shown in Fig 4.2 by clicking T4S Gateway-> Material Master-

> Create Direct. The T4S transfer window of Material Master-Create 

Direct is shown as Fig 4.3 

 



40 
 

 

 

Figure 4.2 Screen print of creating material master through T4S in TC PLM 

 

 

Figure 4.3 Screen print of T4S transfer window of Material Master-Create Direct 

 

Step 3: Checked the moved materials in SAP ERP system by using 

transaction code MM03 as shown in Fig 4.4. The search results of 

checking material master in SAP ERP are shown as Fig 4.5 
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Figure 4.4 Screen print of SAP ERP transaction MM03 

 

 

Figure 4.5 Screen print of material master created in SAP ERP through T4S 

 

Step 4: In “My Teamcenter” screen, moved BOM Structure from TC PLM to 

SAP ERP through T4S transaction window as shown in Fig 4.6 and Fig 

4.7 by clicking T4S Gateway-> Bill of Material -> Create Direct. All BOM 
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structure in assembly and subassembly need to move through T4S 

model “Bill of Material-Create Direct”. In this scenario, the BOM 

structure 5-2-11/A-View, 5-2-12/A-View, 5-2-2/A-View, and 5-3-18/A-

View as shown in Fig 4.8 were transferred from TC PLM to SAP ERP. 

 

 

Figure 4.6 Screen print of T4S model Bill of Material- Create Direct 

 

Figure 4.7 T4S transfer window of Bill of Material-Create Direct 
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 Figure 4.8 Screen print of all BOM structures of 5-3-18 in TC PLM 

 

Step 5: Checked the material BOM of finished product in SAP by using 

transaction code CS03 as shown in Fig 4.9. The BOM structures of 5-3-

18 and its subassemblies 5-2-2, 5-2-11, and 5-2-12 are shown as Fig 

4.10 to Fig 4.13. 

 

 

Figure 4.9 Screen print of SAP ERP transaction CS03 
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Figure 4.10 Screen print of displaying BOM 5-3-18 in SAP ERP 

 

 

Figure 4.11 Screen print of displaying subassembly 5-2-2 in SAP ERP 

 

 

Figure 4.12 Screen print of displaying subassembly 5-2-11 in SAP ERP 
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Figure 4.13 Screen print of displaying subassembly 5-2-12 in SAP ERP 

 

4.2.2 Scenario 2  

In this scenario, a new product on the BOM in TC PLM was added, and then 

the related BOM in SAP ERP was synchronized. The T4S model-Change Master 

was used for synchronizing the related BOM in SAP ERP with the BOM in TC 

PLM system. The BOM data transferred in scenario 2 were recorded in Table 4.2. 

 

Table 4.2 

The records of BOM 5-3-18 under engineering change in scenario 2 

  
BOM in TC PLM 

   
  

BOM in SAP ERP 
Part 
No. 

Quantit
y  

Unit   Structure 
 Part 

No. 
Quantity Unit   Structure 

               
5-3-18 1 Each End-Product  5-3-18 1 Each End-Product 
5-1-1 1 Each Component  5-1-1 1 Each Component 
5-2-2 1 Each Subassembly  5-2-2 1 Each Subassembly 
5-1-3 1 Each Component  5-1-3 1 Each Component 
5-1-6 1 Each Component  5-1-6 1 Each Component 
5-1-7 2 Each Component  5-1-7 2 Each Component 
5-1-8 2 Each Component  5-1-8 2 Each Component 
5-1-10 1 Each Component  5-1-10 1 Each Component 
5-2-11 1 Each Subassembly  5-2-11 1 Each Subassembly 
5-1-4 1 Each Component  5-1-4 1 Each Component 
5-1-5 1 Each Component  5-1-5 1 Each Component 
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Table 4.2 (continued) 

The records of BOM 5-3-18 under engineering change in scenario 2 

5-1-9 2 Each Component  5-1-9 2 Each Component 
5-2-12 1 Each Subassembly  5-2-12 1 Each Subassembly 
5-1-13 1 Each Component  5-1-13 1 Each Component 
5-1-14 1 Each Component  5-1-14 1 Each Component 
5-1-15 1 Each Component  5-1-15 1 Each Component 
5-1-16 1 Each Component  5-1-16 1 Each Component 
5-1-17 1 Each Component  5-1-17 1 Each Component 
5-1-99 1 Each Component  5-1-99 1 Each Component  

 

Step 1: In “Structure Manager” screen, clicked 5-3-18, and then created a 

new part 5-1-99 to BOM 5-3-18 in TC PLM system as shown in Fig 

4.14 by clicking File-> New-> Part. The new BOM 5-3-18 after this 

change is shown as Fig 4.15, where the new part 5-1-99 is added on 

BOM 5-3-18. 

 

 

Figure 4.14 Screen print of opening transaction to create new part in TC PLM 
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Figure 4.15 Screen print of BOM 5-3-18 after adding new product part 5-1-99 

 

Step 2: Moved 5-1-99 from TC PLM to SAP ERP through T4S model as 

shown in Fig 4.16 and Fig 4.17 by clicking T4S Gateway-> Material 

Master -> Create Direct. 

 

 

Figure 4.16 Screen print of opening T4S model Material Master-Create Direct 
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Figure 4.17 T4S transfer window of Material Master-Create Direct 
 

Step 3: Updated the related BOM in SAP ERP through TC PLM workflow 

process of T4S_BOM as shown in Fig 4.18 and Fig 4.19. 

 

 

Figure 4.18 Screen print of opening workflow process in TC PLM 
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Figure 4.19 Screen print of T4S_BOM workflow in TC PLM system 

 

Step 4: Checked the related BOM in SAP ERP system by using transaction 

code CS03 as shown in Fig 4.20. 

 

 

Figure 4.20 Screen print of BOM 5-3-18 in SAP ERP  

 

Step 5: In “My Teamcenter” screen, created change request S2 as shown 

in Fig 4.21 by clicking File-> New-> Classic Change, and attached 5-3-
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18 to this change request by pasting 5-3-18 in the folder of affected 

items as shown in Fig 4.22. 

 

 

Figure 4.21 Screen print of opening classic change in TC PLM 

 

 

Figure 4.22 Screen print of adding BOM 5-3-18 to change request S2 

 

Step 6: Created a change master for the related BOM in SAP ERP system 

through T4S transfer window as shown in Fig 4.23 and Fig 4.24 by 

clicking T4S Gateway-> Change Master -> Create Direct. 
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Figure 4.23 Screen print of opening T4S model Change Master-Create Direct 

 

 

Figure 4.24 Screen print of T4S transfer window of Change Master-Create Direct 

 

Step 7: Checked the change master created in SAP ERP system as shown 

in Fig 4.25 and Fig 4.26 by using transaction code CC03. 
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Figure 4.25 Screen print of searching change master in SAP ERP  

 

 

Figure 4.26 Screen print of displaying change master created in SAP ERP 

 

Step 8: In “My Teamcenter” screen, released the change request S2 

through workflow process of T4S_ECM as shown in Fig 4.27 and 4.28 

by clicking File-> New-> Workflow Process. 
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Figure 4.27 Screen print of opening workflow processes in TC PLM 

 

 

Figure 4.28 Screen print of releasing change request S2 through T4S_ECM 

workflow 
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4.2.3 Scenario 3 

In this scenario, a new part from SAP ERP was imported to TC PLM. A BOM 

in TC PLM was modified by adding this new part, and then the related BOM in 

SAP ERP was synchronized. The BOM data transferred in scenario 3 were 

recorded as Table 4.3. 

 

Table 4.3 

The records of BOM 5-3-18 under engineering change in scenario 3 

  
BOM in TC PLM 

   
  

BOM in SAP ERP 

Part No. 
Qua
ntity  

Unit   Structure 
 Part 

No. 
Qua
ntity  

Unit   Structure 

               
5-3-18 1 Each End-Product  5-3-18 1 Each End-Product 
5-1-1 1 Each Component  5-1-1 1 Each Component 
5-2-2 1 Each Subassembly  5-2-2 1 Each Subassembly 
5-1-3 1 Each Component  5-1-3 1 Each Component 
5-1-6 1 Each Component  5-1-6 1 Each Component 
5-1-7 2 Each Component  5-1-7 2 Each Component 
5-1-8 2 Each Component  5-1-8 2 Each Component 
5-1-10 1 Each Component  5-1-10 1 Each Component 
5-2-11 1 Each Subassembly  5-2-11 1 Each Subassembly 
5-1-4 1 Each Component  5-1-4 1 Each Component 
5-1-5 1 Each Component  5-1-5 1 Each Component 
5-1-9 2 Each Component  5-1-9 2 Each Component 
5-2-12 1 Each Subassembly  5-2-12 1 Each Subassembly 
5-1-13 1 Each Component  5-1-13 1 Each Component 
5-1-14 1 Each Component  5-1-14 1 Each Component 
5-1-15 1 Each Component  5-1-15 1 Each Component 
5-1-16 1 Each Component  5-1-16 1 Each Component 
5-1-17 1 Each Component  5-1-17 1 Each Component 
5-1-99 1 Each Component  5-1-99  1 Each Component  
TE00R 1 Each Component  TE00R 1 Each Component 

 

Step 1: Created a new product part by using transaction code MM01 in 

SAP ERP as shown in Fig 4.29. 
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(1) 

 

(2) 

Figure 4.29 (1)-(2) Screen print of creating TE00R in SAP ERP 
 

Step 2: Searched new product part TE00R stored in SAP ERP by openning 

search view, and choosing T4S_DEMO_QUERY in TC PLM as shown in 

Fig 4.30 and Fig 4.31. Imported TE00R from SAP ERP into TC PLM by 

importing T4S Query row as shown in Fig 4.32. 
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(1) 

 

(2) 
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(3) 

Figure 4.30 (1)-(3) Screen print of opening T4S_Demo_Query in TC PLM 
 

 

Figure 4.31 Screen print of search results in TC PLM 
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Figure 4.32 Screen print of importing TE00R through T4S query row 

 

Step 3: In “structure manager “ screen, searched  TE00* in search bar and 

added TE00R to 5-3-18 as shown in Fig 4.33-Fig 4.35 by copying and 

pasting TE00R to 5-3-18 BOM structure. Fig 4.36 shows the BOM 

strucure of 5-3-18 in scenario 3. 

 

 

Figure 4.33 Screen print of searching TE00R in TC PLM 
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Figure 4.34 Screen print of copying TE00R 

 

 

Figure 4.35 Screen print of pasting TE00R to BOM 5-3-18 
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Figure 4.36 Screen print of BOM 5-3-18 in scenario 3 

 

Step 4: Updated the related BOM in SAP ERP through T4S_BOM workflow. 

Open a new workflow process as shown in Fig 4.37- Fig 4.38 by clicking 

File-> New-> Workflow Processes. 

 

 

Figure 4.37 Screen print of opening workflow process in TC PLM 
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Figure 4.38 Screen print of workflow process of T4S_BOM in TC PLM 

 

Step 5: Checked the related BOM in SAP ERP system as shown in Fig 

4.39 by using transaction code CS03. 

 

 

Figure 4.39 Screen print of BOM 5-3-18 in SAP ERP in scenario 3 
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Step 6: In “My Teamcenter” screen, created Change Request S3 in TC 

PLM system as shown in Fig 4.40 by opening classic change, and 

attached 5-3-18 to this Change Revision as shown in Fig 4.41. 

 

 

Figure 4.40 Screen print of opening classic change in TC  

 

 

Figure 4.41 Screen print of attaching 5-3-18 as affected item of change request 

S3 
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Step 7: Created a Change Master for the related BOM in SAP ERP system 

as shown in Fig 4.42 by clicking T4S Gateway-> Change master-> Create 

Direct, and transferred change request S3 from TC PLM to SAP ERP 

through T4S transfer window of Change Master-Create Direct as shown in 

Fig 4.43. 

 

 

Figure 4.42 Screen print of opening T4S model Change Master-Create Direct 

 

 

Figure 4.43 Screen print of T4S transfer window of Change Master –Create 

Direct 
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Step 8: Checked the SAP Change Master in SAP ERP system by using 

transaction code CC03 as shown in Fig 4.44 and Fig 4.45. 

 

 

Figure 4.44 Screen print of SAP transaction CC03 

 

 

Figure 4.45 Screen print of displaying change request S3 in SAP ERP 
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Step 9:  Released the Change Revision through workflow process of 

T4S_ECM as shown in Fig 4.46-Fig 4.47. 

 

 

Figure 4.46 Screen print of opening workflow processes in TC PLM 

 

 

Figure 4.47 Screen print of releasing change request S3 through T4S_ECM 

workflow 
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CHAPTER 5.  SUMMARY, DISCUSSION AND FUTURE RESEARCH 

This study developed a sandbox for demonstrating BOM transmission in a 

PLM and ERP integrated system. The study helps to enhance user’s 

comprehension of how to relate business processes to transactions in a PLM and 

ERP integrated system. In chapter 4, key considerations of integration and the 

key steps of BOM transmission scenarios and findings were presented. The 

BOM accuracy was also examined by comparing BOM data in the PLM system 

to BOM data in the ERP system after implementing engineering changes. 

 

5.1 Research results summary 

Key considerations of integrating PLM and ERP systems, including data and 

process ownership, master source of information, and the level of integration, 

were discussed. BOM and change request data was shared between the PLM 

and ERP integrated systems. In order to ensure the data consistency, the PLM 

system was assigned as “owner” and “controller”, as BOM data and change 

request data was generated from the processes of engineering design. The PLM 

system was the only source of BOM and change request data, which was 

integrated between PLM and ERP. The direction of data flow was decided based 



67 

 

on work scenario requirements. For example, the product part information was 

bi-directional between PLM and ERP, as in concurrent engineering scenarios, 

where the design engineer who stores data in the PLM system or the sourcing 

engineer who stores data in the ERP system may create new product part data. 

Meanwhile, the accessibility of information and the system assignment of 

business processes were determined to meet specific needs for the work 

scenarios. The manufacturing engineer (in ERP) needed to check the BOM and 

BOM change request data that was created by the design engineer in the PLM 

system, so the BOM and change request data was accessible in both systems. 

The process of creating and editing BOM and change request was managed in 

PLM, as PLM was the only source of BOM and change request data in this study. 

The Enterprise Application Integration (EAI) tool can automatically create the 

BOM and change request data in the ERP system. 

Key steps for transferring BOM data in the TC PLM and SAP ERP integrated 

system was documented through screen prints of the transferring processes. By 

summarizing the data collected in these three scenarios, the BOM transmission 

processes in this study included both forward mapping and reverse mapping. 

The forward mapping shows the direction of data flow from TC PLM to SAP ERP, 

while the reverse mapping shows the direction of data flow from SAP ERP to TC 

PLM. Fig 5.1 shows the data transferred path. The data elements from the BOM 

View, Item Revision and EngChange Revision were moved from TC PLM to SAP 

ERP as BOM, Material Master and EngChange, while the Material Master data 
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field was successfully moved from SAP ERP to TC PLM as Item Revision in this 

study.  

 

 

Figure 5.1 The data transferred path in this study 

 

In Fig 5.2, forward mapping was performed between the PLM and ERP 

integrated systems, and the data types of BOM View, Item Revision in TC PLM 

were successfully transferred to SAP ERP as BOM and Material Master. The  

 

 

Figure 5.2 The data transferred plan for scenario 1 

BOM transmission process in scenario 1 represents the following work scenario 

in a company:  after design engineers creating BOM for a product in TC PLM 

system, the BOM was sent to SAP ERP system through T4S to support 

manufacturing operations. Before implementing T4S transactions, the SAP ERP 
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system did not have any material master and BOM data. BOM data can be 

created in the ERP system through the transactions listed in scenario 1. 

As shown in Fig 5.3, forward mapping was performed. The BOM View, Item 

Revision, and EngChange Revision data fields in TC PLM were successfully 

transferred to SAP ERP as BOM, Material Master and Eng Change. In the work  

 

 

Figure 5.3 The data transferred plan for scenario 2 

 

scenario represented by BOM transmission scenario 2, design engineers 

changed BOM data in the TC PLM system, and then synchronized the related 

BOM in SAP ERP through T4S transactions. A request for this engineering 

change was created in TC PLM, and was sent to SAP ERP through T4S 

transactions. All changes on the BOM in SAP ERP were implemented using T4S 

transactions. The design engineer can easily synchronize the BOM change on 

TC PLM to SAP ERP without extra transactions in SAP ERP.  

In Fig 5.4, forward mapping and reverse mapping were successfully performed. 

The data types of BOM View, EngChange Revision in TC PLM were transferred 

to SAP ERP as BOM and EngChange, while the data types of Material Master in 

SAP ERP were successfully transferred to TC PLM as Item Revision in scenario 

3. In this work scenario, sourcing engineers, who typically work in SAP ERP 
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system, introduced a new part from a supplier company by creating this new part 

data in SAP ERP system. Design engineers searched this new part number in 

TC PLM system through T4S transaction, and imported this new part to TC PLM 

system from SAP ERP. After using this new part to modify the product BOM in 

the TC PLM system, the related BOM was synchronized in SAP ERP through 

workflow processes. An engineering change request was created in TC PLM to 

reflect this change, and was sent to SAP ERP through T4S transactions. The 

engineers who work separately on either a PLM or ERP system can share 

information in this manner in PLM and ERP integrated systems. 

 

 

Figure 5.4 The data transferred in scenario 3 

 

The BOM transmission of three work scenarios was validated by visually 

comparing BOM data in TC PLM to the related BOM data in SAP ERP. The 

product parts and BOM structures observed in SAP ERP matched the data in TC 

PLM in scenario 1. In scenario 2, a change of BOM observed in SAP ERP was 

the same as change of BOM in TC PLM. A new product part 5-1-99 was added 

on BOM 5-3-18 in TC PLM system, and a related BOM in SAP ERP system was 

updated through engineering change management workflow successfully. In 
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scenario 3, a product part in SAP ERP was searched and imported to TC PLM. 

The design engineer can synchronize BOM in TC PLM to SAP ERP without extra 

transactions in SAP ERP and use information stored in SAP ERP in the PLM and 

ERP integrated system.  Additional validation for the SAP ERP system 

configuration and expected material master data was performed through 

comparing the material master data from a separate SAP client dataset.  This 

allowed the researcher to validate the typical data that would be present in the 

material master file.  The TC PLM validation was conducted through discussions 

with the TC PLM experts in the PLM Center.  The data was verified for 

consistency with the typical TC PLM data files.  

 

5.2 Discussion 

A sandbox was developed for demonstrating BOM transmission in a PLM and 

ERP integrated system. Key considerations of integration and key steps of BOM 

transmission scenarios were documented. This research can help to enhance 

users’ understanding on a PLM and ERP integrated system by demonstrating the 

linkage of business processes and transactions in a PLM and ERP integrated 

system, and providing an overview of BOM transmission processes in this 

integrated system. This knowledge may help companies make decisions when 

choosing software systems for their business or to improve business process by 

introducing integrated system. The biggest challenges were to identify key 

considerations for the integration objective, as it requires knowledge of the 

systems—the PLM system, the ERP system and the EAI system. Either TC PLM 
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or SAP ERP system can work as the master to own and control information and 

processes in a PLM and ERP integrated system. The PLM system is generally 

chosen to be the master in a company where BOM and change request data is 

generated from the processes of engineering design. However, in a company 

who assembles purchased and semi-finished products, it may be better to 

choose the ERP system as the master.  For these companies, the majority of 

necessary data for the processes of procurement and fulfillment, so generally the 

ERP system should control the data transmissions.  

The BOM transmission processes were identified by reviewing documents 

about engineering change and concurrent engineering. The knowledge of the 

PLM and EAI systems was gained by studying user manuals. Knowledge of the 

ERP system was gained by studying the SAP ERPSim game. When launching a 

project of integrating PLM and ERP in a company, besides having experts of 

Information Technology, it is better to involve experts from different departments 

in this company to generate a detailed list of integration objectives. These 

experts need to have enough knowledge of work scenarios and business 

processes, such as designing, manufacturing, accounting  and other key 

processes can be developed from these objectives to ensure the PLM and ERP 

integrated system meets users’ needs. Integration objectives include, but are not 

limited to, the product properties, the processes related to the product, and 

workflow of processes.  

This study enhanced the collaboration between unique functional areas at 

Purdue University including the Supply Chain Management Technology 
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Laboratory, College of Technology PLM Center, Information Technology at 

Purdue and Purdue Engineering Computer Network. Several months were 

required to install and configure software, and several technical problems 

occurred during this process, such as the disconnection between TC PLM 

servers and SAP ERP, and transaction failures of T4S. These experiences 

provided learning opportunities for all participants, and enhanced the programing 

and system configuration and integration skills, which are required to build the 

PLM and ERP integrated system in a laboratory environment. This sandbox was 

developed in a lab environment, which has the risk of oversimplification.   

 

5.3 Future research 

To validate the sandbox developed for this research, future cooperation with 

industry to develop research scenarios might be needed. A future study may also 

improve this sandbox by evaluating users’ learning performance on using 

transactions in the PLM and ERP integrated. Future research topics could be 

created to demonstrate BOM transmission processes under different workflow 

designs. The complexity of engineering change management increases as the 

user roles in workflow increase. The processes of BOM transmission might vary 

under different workflow designs. Another future expansion could incorporate TC 

MRO (Maintenance, repair, and overhaul) software functionality in the TC PLM 

and SAP ERP integrated system. By sharing and updating complete and 

accurate maintenance information in the PLM and ERP integrated system, 

maintenance data visibility might be enhanced.  A sandbox could be developed 
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to demonstrate BOM transmission processes in an aftermarket supply. The 

results of this research can help users understand how the PLM and ERP 

integrated system involves with aftermarket supply chain and then help to 

facilitate the process of supply chain integration.  Additional research addressing 

unique industry needs would enhance the existing sandbox, and better replicate 

complicated product designs within companies. 
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Appendix A Configuration of products in TC PLM system 

In this study, the configuration of products in the TC PLM system included four 

steps shown as follows: 

1) Created Top Assembly. 

a. Opened Structure Manager  in TC PLM system 

b. Created new Items by following path: File-> New-> Item, and name the 

part and click Assign, then click next. 

 

A 4 Screen print of creating new Items in TC PLM system 
          

2) Created subassembly under the top assembly  

a. Chose the Top Assembly item in Structure Manager 

b. Created new Items by following path:  File-> New-> Item. 

3) Created new parts in the right assembly level  

a. Chose the assembly level that you want to add new parts in. 

b. Created new parts by following path:  File-> New-> Parts, and 

name the part and click Assign. 



79 

 

 

A 5 Screen print of creating new part in TC PLM  
 

4) Checked the BOM structure for Top Assembly 99-3-1.

 

A 6 Screen print of sample BOM structure 
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Appendix B Configuration of T4S 

The detail steps of configuring T4S are shown in the Teamcenter gateway for 

SAP configuration Guide Version 9.1. The key steps of T4S configuration include: 

1) Configure the data in the Teamcenter Preference by this path: Edit-> Option-> 
Index 

 

B 9 Screen print of T4S configuration path 
 

2) Search “t4s” for all T4S related preferences. 

 

B 10 Screen print of T4S preference 
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3) Export the T4S preferences as xml file, and modify the configuration based on 
this xml.file. When finish modification, import the updated xml.file into system. 

 

B 11 Screen print of uploading T4S preference 
 

4) Specify the mapping in the mapping files 

 

B 12 Screen print of T4S mapping file path in this study 
 

5) Create the compilation of all mapping source files: t4s_mapping_config.rfdt . 
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a. Run mmap.exe 

 

B 13 Screen print of T4S application files path in this study 
 

b. Find t4s_mapping_config.rfdt in the folder of T4SAPP\tmp  

 

B 14 Screen print of T4S configuration file in this study 
 

c. Move this file to <T4S_ROOT>\lib 

 

B 15 Screen print of T4S RFDT file path in this study 
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d. Restart T4S by running restart.exe 

 

B 16 Screen print of T4S application of restart in this study  
 
  
 
 


	Purdue University
	Purdue e-Pubs
	Spring 2014

	A Sandbox Development For Demonstrating Bom Transmission In A Plm And Erp Integrated System
	Zhen Zeng
	Recommended Citation



